ECDL Module 6

REFERENCE MANUAL

Presentation

Microsoft PowerPoint 2000 Edition for ECDL Syllabus Four

www.cheltenhamcourseware.com
ECDL Approved Courseware

IMPORTANT - PLEASE READ
As a condition of providing official approval for this courseware, the ECDL Foundation demand that the following statement appear within all approved ECDL courseware, produced by third party courseware providers:

"European Computer Driving Licence" and ECDL and Stars device are registered trade marks of the European Computer Driving Licence Foundation Limited in Ireland and other countries. Cheltenham Courseware Ltd. is an independent entity from the European Computer Driving Licence Foundation Limited, and not affiliated with the European Computer Driving Licence Foundation Limited in any manner. ‘Cheltenham Courseware Ltd. ECDL Courseware’ may be used in assisting students to prepare for the European Computer Driving Licence Examination. Neither the European Computer Driving Licence Foundation Limited nor Cheltenham Courseware Ltd. warrants that the use of this ‘Cheltenham Courseware Ltd. ECDL Courseware’ will ensure passing the relevant Examination. Use of the ECDL-F approved Courseware Logo on this product signifies that it has been independently reviewed and approved in complying with the following standards:

Acceptable coverage of all courseware content related to the ECDL Syllabus Version 4.0. This courseware material has not been reviewed for technical accuracy and does not guarantee that the end user will pass the associated ECDL Examinations. Any and all assessment tests and/or performance based exercises contained in this ‘Cheltenham Courseware Ltd. ECDL Courseware’ relate solely to this ‘Cheltenham Courseware Ltd. ECDL Courseware’ and do not constitute, or imply, certification by the European Driving Licence Foundation in respect of any ECDL Examinations. For details on sitting ECDL Examinations in your country please contact the local ECDL Licensee or visit the European Computer Driving Licence Foundation Limited web site at http://www.ecdl.com.

“Candidates using this courseware material should have a valid ECDL/ICDL Skills Card/Log book. Without such a skills card/Log book no ECDL/ICDL tests can be taken, no ECDL/ICDL certificate, nor any other form of recognition can be given to the candidate, ECDL/ICDL Skills Cards may be obtained from any accredited ECDL/ICDL Test Centre or from your country’s National ECDL/ICDL designated Licensee”.

References to the European Computer Driving Licence (ECDL) include the International Computer Driving Licence (ICDL). ECDL Syllabus Version 4.0 is published as the official syllabus for use within the European Computer Driving Licence (ECDL) and International Computer Driving Licence (ICDL) certification programme.*

IMPORTANT: - Regarding ECDL courseware purchased from Cheltenham Courseware Ltd. Cheltenham Courseware Ltd. accept no liability whatsoever arising from any changes which you make to this courseware, with, or without, ECDL Foundation approval.
6.1 GETTING STARTED

6.1.1 FIRST STEPS WITH PRESENTATIONS

6.1.1.1 Open (and close) a presentation application.
6.1.1.2 Open one or several presentations.
6.1.1.3 Create a new presentation (default template).
6.1.1.4 Save a presentation to a location on a drive.
6.1.1.5 Save a presentation under another name.
6.1.1.6 Save a presentation in another file type such as: Rich Text Format, template, image file format, software specific file extension, version number.
6.1.1.7 Switch between open presentations.
6.1.1.8 Use available Help functions.
6.1.1.9 Close a presentation.

6.1.2 ADJUST SETTINGS

6.1.2.1 Use magnification/zoom tools.
6.1.2.2 Display or hide built-in toolbars.
6.1.2.3 Modify basic options/preferences in the application: user name, default directory/folder to open, save presentations.

6.2 DEVELOPING A PRESENTATION

6.2.1 PRESENTATION VIEWS

6.2.1.1 Understand the uses of different presentation view modes.
6.2.1.2 Change between different presentation view modes.

6.2.2 SLIDES

6.2.2.1 Add a new slide with specific slide layout inc: title slide, chart & text, bulleted list, table.
6.2.2.2 Change between built-in slide layouts.
6.2.2.3 Change background colour on specified slide(s), all slides.

6.2.3 USING DESIGN TEMPLATES

6.2.3.1 Apply an available design template to a presentation.
6.2.3.2 Change between available design templates.

6.2.4 MASTER SLIDE

6.2.4.1 Insert a picture, image, drawn object into a master slide. Remove a picture images, drawn object from a master slide.
6.2.4.2 Add text into a footer of specific slides, all slides in a presentation.
6.2.4.3 Apply automatic slide numbering, automatically updated date, non-updating date into Footer of specific slides, all slides in a presentation.

6.3 TEXT AND IMAGES

6.3.1 TEXT INPUT, FORMATTING

6.3.1.1 Add text into a presentation in standard or outline view.
6.3.1.2 Edit slide content, notes pages contents by inserting new characters, words.
6.3.1.3 Change text appearance: font sizes and font types.
6.3.1.4 Apply text formatting such as bold, italic or underlining.
6.3.1.5 Apply case changes to text.
6.3.1.6 Apply different colours to text.
6.3.1.7 Apply shadow to text.
6.3.1.8 Align text: left, centre, right in a slide.
6.3.1.9 Adjust line spacing before and after bulleted, numbered points.
6.3.1.10 Change between style of bullets or numbers in a list from the built-in standard options.
6.3.1.11 Use the undo or redo command.

6.3.2 PICTURES, IMAGES

EXTRA - Picture Selection Techniques

6.3.2.1 Insert a picture into a slide.
6.3.2.2 Insert an image into a slide.

6.3.3 DUPLICATE, MOVE, DELETE

6.3.3.1 Duplicate text, pictures, images within the presentation or between open presentations.
6.3.3.2 Move text, pictures, images within the presentation or between open presentations.
6.3.3.3 Resize pictures, images in a presentation.
6.3.3.4 Delete text, pictures, images in a slide.
6.4 CHARTS/GRAPHS DRAWN OBJECTS ............................................................................................................................... 52

6.4.1 USING CHARTS/GRAPHS .............................................................................................................................................. 52

6.4.1.1 Input data to create or modify different kinds of built-in charts/graphs in a slide such as: column, bar, line, pie. ............................................................................................................................... 52
6.4.1.2 Change the background colour in the chart/graph .................................................................................................................. 55
6.4.1.3 Change the column, bar, line, pie slice colours in the chart/graph ...................................................................................... 56
6.4.1.4 Change the chart/graph type .................................................................................................................................................. 57

6.4.2 ORGANISATION CHARTS ............................................................................................................................................. 57

6.4.2.1 Create an organisation chart with a labelled hierarchy ........................................................................................................ 58
6.4.2.2 Change the hierarchical structure of an organisation chart ................................................................................................ 58
6.4.2.3 Add or remove managers, co-workers, subordinates in an organisation chart ........................................................................ 59

6.4.3 DRAWN OBJECTS .......................................................................................................................................................... 59

6.4.3.1 Add different types of drawn object to a slide: line, free drawn line, arrow, rectangle, square, circle, text box, other available shapes ........................................................................................................... 60
6.4.3.2 Change drawn object background colour, line colour, line weight, line style ............................................................................... 63
6.4.3.3 Change arrow start style, arrow finish style .......................................................................................................................... 65
6.4.3.4 Apply a shadow to a drawn object .......................................................................................................................................... 65
6.4.3.5 Rotate or flip a drawn object ................................................................................................................................................ 66
6.4.3.6 Align a drawn object: left, centre, right, top, bottom of a slide .................................................................................................. 67
6.4.3.7 Resize drawn object, chart within a presentation .............................................................................................................. 67
6.4.3.8 Bring an object to the front or back ........................................................................................................................................ 68

6.4.4 DUPLICATE, MOVE, DELETE ........................................................................................................................................... 68

6.4.4.1 Duplicate a chart/graph, drawn object within the presentation or between open presentations .......................................................................................................................... 68
6.4.4.2 Move a chart/graph, drawn object within the presentation or between open presentations .................................................................................................................................................. 69
6.4.4.3 Delete a chart/graph, drawn object ........................................................................................................................................ 69

6.5 SLIDE SHOW EFFECTS ......................................................................................................................................................... 70

6.5.1 PRESET ANIMATION .................................................................................................................................................. 70

6.5.1.1 Add preset text or image animation effects to slides. Change preset animation effects on text or images .................................................................................................................................................. 70

6.5.2 TRANSITIONS .............................................................................................................................................................. 71

6.5.2.1 Add transition effects between slides. Change transition effects between slides .............................................................................................. 72

6.6 PREPARE OUTPUT .......................................................................................................................................................... 73

6.6.1 PREPARATION .......................................................................................................................................................... 73

6.6.1.1 Select appropriate output format for slide presentation such as: overhead, handout, 35 mm slides, on-screen show .......................................................................................................................... 73
6.6.1.2 Spell-check a presentation and make changes such as: correcting spelling errors, deleting repeated words .................................................................................................................................................. 73
6.6.1.3 Add notes (for the presenter) to slides ........................................................................................................................................ 74
6.6.1.4 Change slide setup, slide orientation to portrait, landscape. Change paper size .................................................................. 75
6.6.1.5 Duplicate, move slides within a presentation, between open presentations .................................................................................. 76
6.6.1.6 Delete a slide, slides .................................................................................................................................................. 77

6.6.2 PRINTING .............................................................................................................................................................. 77

6.6.2.1 Print entire presentation, specific slides, handouts, notes pages, outline view of slides, number of copies of presentation, print presentation to file .............................................................................. 77

6.6.3 DELIVER A PRESENTATION ......................................................................................................................................... 80

6.6.3.1 Hide or show slides .................................................................................................................................................. 80
6.6.3.2 Start a slide show, start a slide show on any slide .................................................................................................................. 81
6.1 Getting Started

6.1.1 First Steps with Presentations

6.1.1.1 Open (and close) a presentation application.

To open (start) PowerPoint using the Start Menu
- Display the Start Menu and select Microsoft PowerPoint. (This is normally located in the Programs group).

To close PowerPoint
- Open the File menu and select Close or click on the Close icon (the small cross at the top-right of the application window). If unsaved changes have been made to your presentation a dialog box is displayed, giving you the chance to save the presentation, prior to closing the program.

- Click Yes to save the presentation before closing
  OR click No to close without saving changes
  OR click on the Cancel button to cancel the operation.

6.1.1.2 Open one or several presentations.

To open an existing presentation
- Click on the Open icon.
The **Open** dialog box is displayed. If the file you want to open is contained in another folder or drive, move to that location using the **Look in:** list box.

- To open the file you require, click on the file to select it and then click on the **Open** button.

### Tools to help you with opening files

- You can use the icons across the top of the **Open** dialog box to help you in locating and selecting the required file.

  ![Icon](image)

  Click on the **Down** arrow to display folders (directories) and drives.

  ![List](image)

  **To move up one folder level:** Click here to move up one folder level in the directory tree.

  ![Search](image)

  **To search the Web:** Click here to search the Web.

  ![Delete](image)

  **To delete a file:** Click here to delete the selected file (you can also select a file and press the **Delete** key).

  ![Folder](image)

  **To create a new folder:** Click here to create a new folder under the selected folder.

  ![View](image)

  **To access tools for file and folder manipulation:** Click here to select different views of your files and folders. Repeatedly clicking on this icon will cycle through the various views available. Click on the drop down arrow next to the icon to see a list of selectable views.
To open a recently used PowerPoint file

- A list of recently opened files is displayed under the **File** menu. You can open these files by clicking on them.

To select (& open) a continuous block of files

- Click on the **Open** icon, which will display the Open dialog box.
- Click on the first file of the block which you wish to select and then whilst depressing the **Shift** key, click on the last file of the required block. When you release the **Shift** key the entire block will remain selected.
- Click on the **Open** button to open the files.

To select (& open) multiple files which are not in a continuous block

- Click on the **Open** icon, which will display the Open dialog box.
- Click on the first file which you wish to select and whilst keeping the **Ctrl** key depressed, click on the other files which you wish to select. When you release the **Ctrl** key, the selected files will continue to be highlighted.
- Click on the **Open** button to open the files.
6.1.1.3 Create a new presentation (default template).

To create a new presentation when starting the PowerPoint application
• Start PowerPoint.
• Select **Blank Presentation** from the dialog box.
• Click **OK**. You will then need to choose a slide layout and enter your text or pictures. Click on the **OK** button to accept the default (Title Slide) offered.

To create a new presentation once PowerPoint is “up and running”
• Open the **File** menu and select **New**.
• Select **Blank Presentation** from the dialog box.
• Click **OK**. You will then need to choose a slide layout and enter your text or pictures.

6.1.1.4 Save a presentation to a location on a drive.

To save a presentation
• Click on the **File** drop down menu and select **Save As** to see the **Save As** dialog box.
• Ensure that you are located in the folder and disk of your choice by clicking the arrow to the right of the **Save in** drop down list box and navigating to your required location.
• Enter the filename in the **File name** text box. Filenames cannot include any of the following characters:
  `/ * ? " > < | : ;`
• Click the **Save** button to complete the file saving process.

To save a file to a diskette (floppy disk)
• Click on the **File** drop down menu and select the **Save As** command. A dialog box will be displayed similar to the illustration shown.
• Click on the down arrow to the right of the **Save in** section of the dialog box, which will display a drop down menu, as illustrated.

• Select the **3 1/2 Floppy (A:)** icon.
• Enter a file name and then click on the **Save** button.

### 6.1.1.5 Save a presentation under another name.

**To save a presentation using another name**
- Click on the **File** drop down menu and select the **Save As** command.
- Within the dialog box displayed, enter a different file name.
- If required also select a different location to which to save your file.
- Click on the **Save** button (within the Save As dialog box) to re-save the file.

### 6.1.1.6 Save a presentation in another file type such as: Rich Text Format, template, image file format, software specific file extension, version number.

**To save a file in a format other than PowerPoint format, such as RTF**
- From the **File** drop down menu, click on the **Save As** command.
- If necessary, select the folder in which you wish to save the file from the **Save in** list box.
- Click on the down arrow to the right of the **Save as type:** box, and select the type of file format which you wish to save the file as, such as **Outline/RTF**.
• Enter a file name and then click on the **Save** button to save it in the required format.

**NOTE:** Some formatting information contained in the original may be lost in the process.

### What is an RTF file?

• An RTF (Rich Text Format) file is a generic file which can be read and used by a wide range of different programs. Thus if you have PowerPoint installed on your PC and wish to send a presentation to someone who has a different version of PowerPoint or maybe a presentation program other than PowerPoint, you might wish to send the file in RTF format.

**NOTE:** If you have used a lot of complex formatting within your presentation, then an RTF file can be a much larger file size compared to a normal PowerPoint file. This may be relevant if you are transferring the file over the Internet (or saving the file to diskette which is limited to a 1.44 Mb storage capacity).

### To save your file in a different PowerPoint version

• This is useful where different departments within your organisation may be using different versions of the Microsoft PowerPoint program. Later versions of PowerPoint will be able to read presentations saved in earlier versions. However if someone, using say PowerPoint 4, received a presentation, formatted in say PowerPoint 2000, they would be unable to open the file. The solution, in this case, is for the person using PowerPoint 2000 to save the file in PowerPoint 4 format, as illustrated (some formatting features may be lost in the process).
To save a file as a template
- A template is a special type of file which can be created once and customised as required. It can then be recycled over and over again.

To save a presentation as image formatted files
- You can if you wish save each slide within your presentation as separate Gif or JPG picture files. Select the required format from within the **Save as Type** section of the Save As dialog box.

To save an entire presentation in Web format
- From the **File** drop down menu, click on the **Save as Web Page** command.
  - Click on the **Save** button to save the presentation in a Web compatible format. Some formatting information contained in the original may be lost in the process.
To save only certain slides within a presentation in HTM (Web format)

- From the **File** drop down menu, click on the **Save as Web Page** command.

- Click on the **Publish** button, which will display a dialog box.

  ![Publish as Web Page dialog box](image)

  **NOTE**: If you are going to use these web files on your web site, you should consider the following option within the **Browser support** section of the dialog box.

  ![Browser support options](image)

- In the **Slide number** section of the dialog box, enter the slides which you wish to publish as web pages. Click on the **Save** button to save the presentation in a Web compatible format.

### 6.1.1.7 Switch between open presentations.
To switch between open presentations

- Each presentation which you open will be displayed as an icon within the Windows Status Bar, (displayed along the bottom of your screen) as illustrated. To switch to the required presentation, simply click on the icon.

6.1.1.8 Use available Help functions.

What is ‘Today’s Tip’?

- By default PowerPoint will display a "tip of the day" each time you start PowerPoint. If you take the time to read these tips as they are displayed, then you will soon find that you are on the way to becoming a PowerPoint expert.

What is the Microsoft Office Assistant?

- By default this friendly little creature will watch what you do and offer tips on how to work more productively. You can ask it questions in plain English. Occasionally the Office Assistant will display information on the screen. If you are unsure about how to use PowerPoint you should always read the help offered. You can choose to implement the tip, have it explained, or to ignore the tip.

To display the Office Assistant

- The Office Assistant is displayed by default. If the assistant has been hidden and you wish to reactivate it, click on the Microsoft PowerPoint Help icon.
To hide the Office Assistant

- Right click on the Office Assistant and from the menu displayed, click on the Hide command.

To use "What is this" Help

- Within many dialog boxes you will see a question mark symbol in the top-right corner of the dialog box. For instance click on the Format drop down menu, select the Font command and this will display the Font dialog box with this sort of help enabled. Not all dialog boxes have this feature however. To use "What is this" Help, click on the question mark and then click on the item in the dialog box which you do not understand.

- In the example shown we have clicked on the Superscript check box within the Format dialog box, and as you can see, help is displayed relating to the Superscript option.

The Help drop down menu

- Click on the Help drop down menu and select the command which you require. Remember that if you move the mouse arrow to the down arrow at the bottom of the menu, the menu will expand to show all available commands, as illustrated.
Microsoft PowerPoint Help - Contents Tab

- Selecting the Contents tab within the Microsoft PowerPoint Help dialog box will display the following window.

![](image)

**Ways to get assistance while you work**

This topic provides reference information about:

- Asking for help from the Office Assistant
- Getting Help from the Help menu
- Getting Help from the Office Update Web site
- Finding out what's new in PowerPoint 2000

**More Information**

**Asking for Help from the Office Assistant**

When you have a question about a Microsoft Office program, you can ask the Office Assistant. For example, to get help about how to format a chart, type *How do I format a chart?* in the Assistant.

If the correct topic doesn’t appear in the Assistant balloon, click None of the above, look for more help on the Web at the bottom of the list of topics. You will get suggestions on how to phrase a question to the Office Assistant or how to narrow your search by using keywords. If you still can’t find the information you want, you can send feedback to improve future versions of help and be automatically connected to the Microsoft Office Update Web site to search for help there.

The Assistant automatically provides help topics and tips on tasks you perform as you work — before you even ask a question. For example, when you write a
In the left side of the window, topics are listed. Clicking on any of the plus symbols will expand the options available, as illustrated. Click on a topic in the left section will display information in the right section of the window.

Microsoft PowerPoint Help – Answer Wizard Tab

- Selecting the Answer Wizard tab within the Microsoft PowerPoint Help dialog box will display the following window.

- Type in a question and click on the Search button. In the example shown, we have asked about setting margins.
• Clicking on the **Search** button will display the following information.

![Microsoft PowerPoint Help – Index Tab](image)

**Microsoft PowerPoint Help – Index Tab**

• Selecting the **Index** tab within the **Microsoft PowerPoint Help** dialog box will display the following window.

![Microsoft PowerPoint Help](image)

• Scrolling down the list on the left and selecting the item will display the required help on the right. Or you might enter a keyword and click on the **Search** button.

**Office on the Web**

• Clicking on this option under the **Help** drop down menu will display the following dialog box. Click on the area of the map relating to your locations, and follow the on-screen directions.
Detect and Repair

- Selecting this option under the Help drop down menu will display the following dialog box. Click on the Start button and follow through the on-screen prompts.

About Microsoft PowerPoint

- Clicking on this option under the Help drop down menu will display the following dialog box. This screen will display the exact release version of the application. It will also display your Product ID (removed in the illustration for security reasons).
6.1.1.9 Close a presentation.

To close a presentation
- Select Close from the File drop down menu

OR click on the Close Window icon displayed at the top-right of the presentation window. Be sure to click on the Close Window icon, (as opposed to the Close icon).

The presentation will be closed and the screen will be cleared. If you try to close a presentation without saving it, PowerPoint displays a dialog box asking if you want to save any of the changes you made to the presentation.

6.1.2 Adjust Settings

6.1.2.1 Use magnification/zoom tools.

To zoom a presentation using the Zoom icon
- This feature allows you to enlarge or reduce the view of a page on the screen. You can display the whole page, or just a section of it. Use the Zoom icon on the Standard toolbar to quickly zoom to certain settings. Click on the down arrow next to the Zoom icon to display a drop down list of pre-set screen zoom values. You can enter any value you like; you do not have to accept the values offered to you.
6.1.2.2 Display or hide built-in toolbars.

To display or hide a toolbar
- To display a toolbar, select the Toolbars command from the View menu to display the Toolbars drop down menu. A list of toolbars is displayed.
- Choose the Toolbar you want to display by clicking on it from the list.

Quick way of displaying / hiding toolbars
- A quick way of displaying/hiding toolbars is to right click on an existing toolbar which will display the Toolbars drop down menu, from which you can select or de-select toolbars.

6.1.2.3 Modify basic options/preferences in the application: user name, default directory/folder to open, save presentations.

To set preference options
- Click on the Tools drop down menu and select the Options command.
To set the user name: Select the General tab, and enter your name in the Name and Initials section of the dialog box. Once set this means that PowerPoint can use the stored information at a later date.

To set the default directory: Select the Save tab, and enter the default file location within the dialog box. Once set this means that open and close dialog boxes will point to the specified folder.
6.2 Developing a Presentation

6.2.1 Presentation Views

6.2.1.1 Understand the uses of different presentation view modes.

Normal View
- When in Normal view, you will see a representation of the slide. Below it is an area for adding speaker’s notes and to the left is a representation of the presentation in Outline view. This is the most versatile view of a presentation when editing and reviewing changes.

Outline View
- The Outline view is useful when creating the outline, or for reviewing a complex presentation produced by somebody else.
Slide View

- The Slide view displays the slide with no notes or outline. It is useful for adding information to an existing presentation.

Slide Sorter View

- This view shows all the slides laid out on the screen, and within this view you can use 'drag and drop' techniques to reorder the slides.
Slide Show View

- The Slide Show view displays the presentation as an on-screen show. This allows you to see the presentation in the same format as it will be presented to an audience.

6.2.1.2 Change between different presentation view modes.

To change between presentation views

- Just above the Windows Status Bar, at the bottom-left of the screen, you will see the PowerPoint View icons. These are used to change the view of the PowerPoint presentation on which you are working. Simply click on the required view icon.

The Views available are:
6.2.2 Slides

6.2.2.1 Add a new slide with specific slide layout inc: title slide, chart & text, bulleted list, table.

To add a new slide with a specific slide layout (using the New Slide icon)
- Click on the **New Slide** icon.

- From the **New Slide** dialog box, select the required slide layout. In the example shown the **Title Slide** layout has been selected.

- Click on the **OK** button to confirm your slide layout selection.

6.2.2.2 Change between built-in slide layouts.

To apply a different slide layout to a slide
- Display a slide within a presentation of which you wish to change the slide layout.
• Right-click on the slide and from the popup menu displayed, select the **Slide layout** command, as illustrated.

![Slide layout dialog box](image)

• This will display the Slide layout dialog box. Select the required slide layout and then click on the **Apply** button. In the example illustrated, the **2 Column Text** slide layout has been selected.

6.2.2.3 Change background colour on specified slide(s), all slides.

**To change the background colour of the selected slide (or for every slide within a presentation).**

• Click on the **Format** drop down menu, and select the **Background** command. This will display a dialog box. Select the required colour.

![Background dialog box](image)

• To apply this background colour to the selected slide, click on the **Apply** button.
To apply this background colour to all the slides within the presentation click on the **Apply to All** button.

**To change the background colour of the multiple selected slides simultaneously**

- Let’s say that you have a slide show made up of many slides and that you wished to change the background colour of some of the slides. To do this, you need to first select the slides which you wish to format with the background colour. Click on the **Slide Sorter View** icon (bottom-left of your screen). Click on the first slide which you wish to select. Whilst depressing the **Ctrl** key, click on the other slides which you wish to select.
- When all the required slides are selected, click on the **Format** drop down menu, and select the **Background** command. This will display a dialog box.
- Select the required colour.
  To apply this background colour to the selected slides, click on the **Apply** button.

### 6.2.3 Using Design Templates

#### 6.2.3.1 Apply an available design template to a presentation.

**To apply a design template**

- Display the presentation to which you wish to apply a design template. Click on the **Format** drop down menu and select the **Apply Template Design** command, which will display a dialog box.

- Select the desired design template, (a visual representation of the design is shown in the right side of the dialog box).
• Click on the **Apply** button.

### 6.2.3.2 Change between available design templates.

**To change to a different design template**

• Display the presentation to which you wish to apply a different design template.

• Click on the **Format** drop down menu and select the **Apply Template Design** command, which will display a dialog box.

• Select the desired design template, (a visual representation of the design is shown in the right side of the dialog box).

• Click on the **Apply** button.

### 6.2.4 Master Slide

**What are Slide Masters and Design Templates?**

• Slide Masters are basically templates which are used to create a new presentation. Click on the **File** drop down menu, and then click on the **New** command. The New Presentation dialog box is displayed. By default the **General** tab is displayed, which contains the default template entitled **Blank Presentation**. However if you investigate the other tabs, such as **Presentation Designs** or **Presentations**, you will see other templates. These templates are held as individual files, with a .POT file extension. You can use the existing PowerPoint templates or create new ones.

• Each presentation which you create will be based on an existing template, often the default Blank presentation template, and it is this template which defines what sort of background colour and graphics will be used in the presentation, along with the positioning of the text as well as the formatting used by the text. Information such as the type of bullet used will be stored within the template file.

• Each template file contains what are called “Masters” which define how the different views will be formatted, i.e. you have a Slide Master, an Outline Master, A Notes Master and a Handouts master.

• The idea of a Slide Master is to help you impose a consistent look and feel on all the presentations which you produce. You can however override the master settings for an individual slide. You can also customise the master settings as used by a particular presentation file.
6.2.4.1 Insert a picture, image, drawn object into a master slide. Remove a picture images, drawn object from a master slide.

To insert a picture into a master slide
- Display an existing presentation within PowerPoint.
- Click on the View drop down menu and select the Master command. From the submenu displayed, select the Slide Master command, which will display the underlying slide master for that presentation.
- Click on the Insert Clip Art icon (within the Drawing toolbar). Select a category and then select an item of clipart. Insert the clipart item.
- Once the required graphic has been inserted, positioned and re-sized as necessary, you can switch back to the normal slide view by clicking on the Normal View icon, displayed at the bottom-left of your PowerPoint screen.

To insert an image (from a file) into a master slide
- Display an existing presentation within PowerPoint.
- Click on the View drop down menu and select the Master command. From the submenu displayed, select the Slide Master command, which will display the underlying slide master for that presentation.
- Click on the Insert drop down menu and select the Picture command. From the submenu displayed, select From File. If necessary browse the hard disk until the required image file is displayed. Select the image file and click on the Insert button.
- Once the required graphic has been inserted, positioned and re-sized as necessary, you can switch back to the normal slide view by clicking on the Normal View icon, displayed at the bottom-left of your PowerPoint screen.

To insert a drawn object into a master slide
- Display an existing presentation within PowerPoint.
- Click on the View drop down menu and select the Master command. From the submenu displayed, select the Slide Master command, which will display the underlying slide master for that presentation.
- Display the drawing toolbar, and create a drawn object, i.e. AutoShape.
- Once the required graphic has been inserted, positioned and re-sized as necessary, you can switch back to the normal slide view by clicking on the Normal View icon, displayed at the bottom-left of your PowerPoint screen.
To remove a graphic from a master slide

- Switch to Slide Master view (by clicking on the View drop down menu, selecting Master, and then from the submenu displayed selecting Slide Master)
- Select the image which you wish to remove (by clicking on it).
- Press the Del key to delete the image.

6.2.4.2 Add text into a footer of specific slides, all slides in a presentation.

To add footer text to a presentation

- Display the presentation to which you wish to add a header or footer.
- Click on the View drop down menu and select the Header and Footer command, which will display a display box. If necessary select the Slide tab.

- Enter the text which you wish displayed on each slide into the area at the bottom of the dialog box.
- Either click on the Apply button to add the header or footer to just the current slide within the presentation or click on the Apply to All button to add the header or footer to all the slides within the presentation.
6.2.4.3 Apply automatic slide numbering, automatically updated date, non-updating date into Footer of specific slides, all slides in a presentation.

To add automated slide numbering and the date to a presentation

- Display the presentation to which you wish to add slide numbering and date information which will automatically update.
- Click on the **View** drop down menu and select the **Header and Footer** command, which will display a display box. If necessary select the **Slide** tab.
- To apply automatic slide numbering, click on the **Slide number** button within the dialog box.

- To apply an automatically updating date, click on the **Update automatically** button within the dialog box.

- Click on the **Apply to All** button to add the header or footer to all the slides within the presentation.
6.3 Text and Images

6.3.1 Text Input, Formatting

6.3.1.1 Add text into a presentation in standard or outline view.

To add text to a slide in standard view

- Click on the Normal view icon (bottom-left of your screen)

The screen layout will be similar to that illustrated.

- Click at the location within a slide to which you wish to add text. As you can see from the illustration below, a text box is displayed.

- Enter your text.
To add text to a slide in Outline view

- Click on the **Outline** view icon (bottom-left of your screen)

- The screen layout will be similar to that illustrated.

- You can if necessary scroll down the text which is displayed in the left section of the dialog box. You can enter new text, or edit existing text, in the same way that you would enter text into a word-processing program. I.e. just click where you wish to enter some text and start typing.

6.3.1.2 Edit slide content, notes pages contents by inserting new characters, words

To edit slide content

- Use the same editing techniques which you would use within a word-processor.

**To insert text**: Click at the point you wish to insert text and start typing.

**To overwrite existing text**: Select the text you wish to replace with new text. Start typing and the new text will replace the old text.
To edit text on a notes page
- To edit notes pages, use the same techniques as above, and edit the notes text which is displayed under the slide in **Normal View**.

### 6.3.1.3 Change text appearance: font sizes and font types.

#### To change the font type used by selected text
- Select the text of which you wish to change the font.
- Click on the down arrow next to the **Font** field in the Formatting toolbar.
- Select the new font from the list displayed.

#### To change the font size used by selected text
- Select the text of which you want to change the font size, or place the insertion point at the location where you want to begin entering text in the new size.
- Enter the font size required into the Font Size field in the Formatting toolbar.
- You can also use the toolbar icons **Increase Font Size** and **Decrease Font Size**.

### 6.3.1.4 Apply text formatting such as bold, italic or underlining.
To format using Bold, italic or underlining

- Select the text you wish to format.
- You can change the font style by clicking the **Bold, Italic, Underline** and **Shadow** icons from the **Formatting** toolbar.

6.3.1.5 Apply case changes to text.

To change text case

- Select the text of which you wish to change the case.
- Click on the **Format** drop down menu and select the **Change Case** command.
- From the dialog box displayed, select the required option and click on the **OK** button to apply the case formatting.

6.3.1.6 Apply different colours to text.

To change the Font colour

- Select the text to which you wish to apply the new colour. Click on the down arrow next to the **Font Color** icon on the Drawing toolbar. Select the required colour from the drop down displayed.

- To see other colours click on the **More Font Colors** command. This will allow you to select more colours, or define your own colours.
6.3.1.7 Apply shadow to text.

To add a shadowed effect to text
- Select the text to which you wish to apply the shadowed effect.
- Click on the **Shadow** icon on the Formatting toolbar.

6.3.1.8 Align text: left, centre, right in a slide.

To change paragraph alignment
- Use the **Align** icons in the toolbar. There are several options available.

  Choose from the following:

  - **Left**: Text is aligned flush with the left-hand edge of a text object (the default).
  - **Right**: Text is aligned flush with the right-hand edge of a text object.
  - **Centre**: Text is centred horizontally between the left and right hand edges of a text object.

- To change the alignment of a paragraph, select the paragraph(s) you wish to change.
• Select **Alignment** from the **Format** menu. A submenu is displayed containing various options.

![Alignment Menu](image)

• Select the option you require.

**To centre text top and bottom**

• By default text boxes automatically wrap and re-size to fit the text within them. However if you wish to set the formatting to align any text within a text box to centre vertically, i.e. between the top and bottom of the text box, then this is how you would do it.

• First click on the text box to select it.

• Right click on the text box to display a popup menu and select the **Format Text Box** command. This will display the Format Text Box dialog box. Select the **Text Box** tab.

![Format Text Box Dialog](image)

• From the **Text anchor point** section of the dialog box, use the drop down arrow to select **Middle Centred**.

**6.3.1.9 Adjust line spacing before and after bulleted, numbered points.**

**To change line and paragraph spacing**

• Line spacing is the amount of space between lines of text or between paragraphs. You may wish to adjust the line spacing to make text easier to read, or to make text fit on a slide. Spacing can be adjusted in lines or points.

• To change the line spacing, select the text or paragraph(s) where you want to adjust the spacing. Select **Line Spacing** from the **Format** menu to display the **Line Spacing** dialog box.
• To adjust the line spacing, use the up and down arrows in the Line spacing box to change the value. Select how you wish to adjust the spacing by choosing **Lines** or **Points** from the drop-down list on the right-hand side of the adjustment box.

• To adjust the paragraph spacing, use the up and down arrows in the **Before paragraph** and **After paragraph** boxes to adjust the value. Select how you wish to adjust the spacing by choosing **Lines** or **Points** from the drop-down list on the right-hand side of the adjustment box.

• Select **Preview** to see the effect the new spacing has on the text. Select **OK** to accept the new spacing attributes.

6.3.1.10 Change between style of bullets or numbers in a list from the built-in standard options.

**To add bullets using the toolbars**

• Select the text to which you want to add bullets.

• Click on the **Bullets** icon in the **Formatting** toolbar.

**To remove bullets**

• Highlight the bulleted text to select it.

• Click the **Bullet On/Off** button on the **Formatting** toolbar to switch the bulleted feature off. The bullets are removed from the text.

**To select a different bullet type**

• Select the text to which you want to add bullets.
• Select **Bullets and Numbering** from the **Format** menu to display the **Bullets and Numbering** dialog box.
• Make sure the **Bulleted** tab is selected. Select the required bullet and click on the **OK** button.

![Bullets and Numbering dialog box]

---

**To select a different numbering format**

• Select the text to which you want to add numbering. Select **Bullets and Numbering** from the **Format** menu to display the **Bullets and Numbering** dialog box. Select the **Numbered** tab. Select the required number format and click on the **OK** button.

![Bullets and Numbering dialog box]

---

**6.3.1.11 Use the undo or redo command.**

**To use the Undo command**

• Click on the **Undo** icon.
To use the Redo command

- Click on the Redo icon.

6.3.2 Pictures, Images

EXTRA - Picture Selection Techniques

To select a picture

- Click on the object to select it

To select multiple pictures

- Click on the first object to select it.
- Depress the Shift key (and keep it depressed)
- Click on other objects which you also wish to select.
- Release the Shift key and all the objects which you have clicked on will remain selected.

To select all pictures within a slide

- Press Ctrl+A

To 'cycle' round all pictures and select them one, by one

- Press the Tab key and each time you press the Tab key, you will cycle round the objects within the slide (including the text boxes)

6.3.2.1 Insert a picture into a slide.
To insert Clipart

- Click on the **Insert Clip Art** icon, located in the **Drawing** toolbar. If the Drawing toolbar is not currently displayed, click on the **View** drop down menu, select **Toolbars**, and from the list displayed select **Drawing**.

You may see a small dialog box reminding you that there is much more clip art available on the Microsoft Office CD-ROM installation disk. If you do see this informational dialog, press **OK** to continue.

- A gallery of clipart will be displayed. Select the group which matches your requirements, such as Academic or animals. In the picture below, the **Animals** clipart has been selected.

- Make sure that the **Pictures** tab is displayed. Use the scroll bars to scroll down through the available clip art.

- Click once on the Clipart which you wish to insert. In the example shown the **frog** picture has been selected.

- Clicking on the first item in the popup menu (**Insert clip**) will paste the clipart into the presentation. You may continue inserting other clipart into your presentation, and when finished, close the clipart dialog box.
To search for clipart pictures

- In the **Search for clips** section of the clipart dialog box, enter a word and press **Enter**. In the example shown, the search word used was **computer**.

6.3.2.2 Insert an image into a slide.

**To import an image from a file**

- Display a slide within your presentation.
- Click on the **Insert** drop down menu, select the **Picture** command, and from the submenu displayed select **From File**.
- If necessary change to the required drive or folder and then select the required picture file. You should see a preview of the selected picture file within the dialog box.

- Once the correct file is selected, click on the **Insert** button and the picture will be displayed within your slide.

**NOTE**: If you click on the down arrow in the **Files of type** section of the **Insert Picture** dialog box, you will see a list of file types which you can insert into your presentation.
6.3.3 Duplicate, Move, Delete

6.3.3.1 Duplicate text, pictures, images within the presentation or between open presentations.

What is the Clipboard?
- The Clipboard is an area of memory in which you can store text or graphics.
- The Clipboard is used to temporarily store data whilst it is being moved between documents or applications, or from one place to another in the same document. If you cut or copy text, graphics, or other items, they will be temporarily stored in the Clipboard ready for use elsewhere.

The Copy command
- When you use the Copy command the Clipboard is used to store a copy of the selected text (or graphics) without removing it from the document. This enables you to paste a copy of the text (or graphics) from the Clipboard to another location in the same document, to a different document, or to another Windows program.

To copy text, graphics, or other items to the Clipboard
- Select the item you wish to copy to the Clipboard.
- From the Edit menu select the Copy command
  OR press Ctrl+C, to move the item to the Clipboard without removing it from the document
  OR you can also use the Copy icon on the Standard toolbar.

Note: With the introduction of Microsoft Office 2000 more than one item may be stored on the Clipboard at the same time, however the facility is only available within Microsoft Office 2000 compatible programs. Normally if you copy more than one item to the Clipboard, the previous items will be lost.
To copy multiple items to the Clipboard

- Since the release of Microsoft Office 2000, you can now store up to 12 items on the Clipboard and when you have copied 12 items you will see a message similar to that illustrated. To copy multiple items, simple select each item (one at a time) and copy it to the clipboard.

To view the Clipboard toolbar (in Office 2000 onwards)

- If the Clipboard toolbar is not displayed, then you can display it by clicking on the View drop down menu, selecting Toolbars, and then selecting Clipboard.

Icons on this toolbar include Copy, Paste All and Clear Clipboard.

The Paste command

- This feature enables you to insert the contents of the Clipboard at another location in the document, in a different document, or in a different Windows program.

To paste data from the Clipboard

- Select the text you wish to Cut or Copy.
- Use the Cut or Copy command to place the data in the Clipboard.
• Then locate the insertion point at a different location within your current document (or indeed in a different document, or even a different Windows program).

• From the Edit menu, choose the Paste command OR press Ctrl+V OR you can also paste items using the Paste icon within the toolbar.

The contents of the Clipboard will appear in the document.

Pasting multiple items from the Clipboard (in Office 2000 onwards)

• If the Clipboard toolbar is not displayed, then you can display it by clicking on the View drop down menu, selecting Toolbars, and then selecting Clipboard.

• Icons on this toolbar include Copy, Paste All and Clear Clipboard. If you move the mouse over one of the icons held within the Clipboard toolbar, then you will see the first 50 characters displayed. If the item is a picture, then the pictures will be labelled in the order in which they were copied to the Clipboard.

• To paste an item simply click on the appropriate icon on the Clipboard toolbar.

To copy using “Drag and Drop”, without placing text in the Clipboard

• Select the text you wish to copy and then place the mouse pointer anywhere over the selected text. Hold down Ctrl and depress the left-hand mouse button. Note that the mouse pointer changes to an arrow with a dotted insertion point contained in a box.

• Drag the mouse pointer to the required new location. Release the mouse button and the Ctrl key to move the text to the new location.

Copying, cutting and deleting images

• You can copy, move and delete images in almost exactly the same way that you would manipulate selected text. You can use drag and drop techniques or use the Clipboard, along with the Cut, Copy and Paste commands.
To copy and paste an image

- Select the image you wish to copy to the Clipboard.
- Then from the Edit menu select the Copy command
  OR press Ctrl+C, to move the image to the Clipboard without removing it from the slide.
  OR you can also use the Copy icon on the Standard toolbar.

- Once the image is stored within the Clipboard, position the insertion point within a slide, at the position where you wish to paste the image. Then click on the Paste icon.

To copy an item from one slide to another within a presentation

- Select the text, image, drawn object, or chart which you wish to copy. Press Ctrl+C to copy the selected item to the Clipboard. Use the Next slide/Previous slide controls to display the slide to which you wish to copy the item.

- If the item which you copied to the Clipboard was text, then click within the slide at the location where you wish to paste the text, or else simply, paste the item into the slide. Remember that the keyboard shortcut to paste is Ctrl+V. If the item was not text, you may have to use the normal 'drag and drop' techniques to move the item within the slide.

To copy an item from a slide in one presentation to a slide within a different presentation

- Select the text, image, drawn object, or chart which you wish to copy. Press Ctrl+C to copy the selected item to the Clipboard. Click on the Window drop down menu, and select the other PowerPoint presentation to which you wish to paste the copied item.
• If necessary, within this second presentation, use the **Next slide/Previous slide** controls to display the slide to which you wish to copy the item.

• If the item which you copied to the Clipboard was text, then click within the slide at the location where you wish to paste the text, or else simply, paste the item into the slide. Remember that the keyboard shortcut to paste is **Ctrl+V**. If the item was not text, you may have to use the normal 'drag and drop' techniques to move the item within the slide.

---

**To copy a slide from one place to another within a presentation**

• Click on the **Slide Sorter View** icon (bottom-left)

• Select the slide which you wish to copy. Press **Ctrl+C** to copy the entire slide to the Clipboard. Click between the two slides to which you wish to paste the copied slide (a thin vertical line marks the insertion point for you). Press **Ctrl+V** to paste the copied slide.

---

**To copy a slide within one presentation to a slide within a different presentation**

• Click on the **Slide Sorter View** icon (bottom-left)

• Select the slide which you wish to copy. Press **Ctrl+C** to copy the entire slide to the Clipboard. Click on the **Window** drop down menu, and select the other PowerPoint presentation to which you wish to paste the copied slide.
• Click on the **Slide Sorter View** icon (bottom-left) so that the slides of the second presentation are displayed in slide sorter view.

• Click between the two slides to which you wish to paste the copied slide (a thin vertical line marks the insertion point for you)

• Press **Ctrl+V** to paste the copied slide.

### 6.3.3.2 Move text, pictures, images within the presentation or between open presentations.

#### The Cut command

• The **Cut** command allows you to remove text, graphics, tables, and other items from a document and store it on the Clipboard. The item can then be pasted from the Clipboard to another location in the document, to another document, or to a document in another Windows program. Remember that, unlike the Copy command, Cut will remove the selected item from the document. You can restore it by using the Undo command.

#### To cut selected items from a document

• Select the items you want to cut. From the **Edit** menu choose the **Cut** command  
  **OR** press **Ctrl+X**, to cut the item from the document and place it on the Clipboard 
  **OR** you can also cut items by clicking on the **Cut** button on the Standard toolbar.

#### To move text using “Drag and Drop”, without storing it on the Clipboard

• Select the text you wish to move. Place the mouse pointer anywhere on the selected text and hold down the left-hand mouse button. Note that the mouse pointer changes to an arrow with a dotted insertion point contained in a box.

• Drag the mouse pointer to a new location. To move the text to its new location, release the mouse button.
To cut (move) an item from one slide to another within a presentation

- Select the text, image, drawn object, or chart which you wish to move. Press Ctrl+X to cut the selected item to the Clipboard. Use the Next slide/Previous slide controls to display the slide to which you wish to move the item.

- If the item which you moved to the Clipboard was text, then click within the slide at the location where you wish to paste the text, or else simply, paste the item into the slide. Remember that the keyboard shortcut to paste is Ctrl+V. If the item was not text, you may have to use the normal 'drag and drop' techniques to move the item within the slide.

To cut (move) an item from a slide in one presentation to a slide within a different presentation

- Select the text, image, drawn object, or chart which you wish to move. Press Ctrl+X to move the selected item to the Clipboard. Click on the Window drop down menu, and select the other PowerPoint presentation to which you wish to paste the cut item.

- If necessary, within this second presentation, use the Next slide/Previous slide controls to display the slide to which you wish to cut the item.

- If the item which you cut to the Clipboard was text, then click within the slide at the location where you wish to paste the text, or else simply, paste the item into the slide. Remember that the keyboard shortcut to paste is Ctrl+V. If the item was not text, you may have to use the normal 'drag and drop' techniques to move the item within the slide.
6.3.3.3 Resize pictures, images in a presentation.

To resize an image, object or chart
- Select the image, object or chart by clicking on it once.
- Move the mouse pointer to one corner of the selected item, until the mouse pointer changes to a line at 45 degrees with an arrowhead at each end.
- Depress the mouse button and drag to resize the image within the slide.
- Release the mouse button.

6.3.3.4 Delete text, pictures, images in a slide.

To delete selected text
- Select the text which you want to delete and press the Delete key.

To delete a picture
- Click on the picture which you wish to select and then press the Delete key.
6.4 Charts/Graphs Drawn Objects

6.4.1 Using Charts/Graphs

6.4.1.1 Input data to create or modify different kinds of built-in charts/graphs in a slide such as; column, bar, line, pie.

To create a column, bar or line chart
- Open or create a presentation. Click on the **Insert** drop down menu and select **Insert Slide**. Select the **Chart AutoLayout**, as illustrated, and click on the **OK** button. An icon is inserted into the slide, as illustrated.
- Double clicking on this icon will insert a Column Chart, using sample data, as illustrated. You can modify the data as required.
- By default a column chart will be created. If you wish to create a different type of chart, then click on the Chart drop down menu and select the Chart Type command.
• From the dialog box displayed, select the required chart type, such as bar or line.

• Click on the OK button to confirm your chart type selection.
• Click on the Close icon (top-left of the spreadsheet window) to complete the process.

**To create a Pie chart**

• Open or create a presentation. Click on the Insert drop down menu and select **New Slide**. Select the **Chart AutoLayout**, as illustrated, and click on the OK button. An icon is inserted into the slide, as illustrated.

• Double clicking on this icon will insert a Column Chart, using the sample data, as illustrated. You can modify the data as required.
NOTE: When wishing to create a Pie chart you have to use only one data series. In the data illustrated, we have three data series, i.e. East, West and North, as illustrated.

- In this case we shall use the East data series, in which case we need to de-select the West and North data series. To do this, double click on the icon numbers to the left of West and North, as illustrated below.

- Now only the East data series is selected.
- Click on the Close icon (top-left of the spreadsheet window) to complete the process.
- To convert the chart from a column chart to a pie chart, click on the Chart drop down menu and select the Chart Type command. This will display the Chart Type dialog box.
• Select the required chart type, in this case a **Pie** chart. You can use the **Chart sub-type** section of the dialog box to make further modifications. Click on the **OK** button to finish the process. The Pie chart will be displayed, as illustrated.

6.4.1.2 Change the background colour in the chart/graph.

**To change the background colour of a chart**

• Display the slide containing the chart which you wish to modify. Double click over the chart area, so that the screen changes as illustrated below (the data used to construct the chart is displayed, and if you look carefully, you will see different icons displayed across the top of your application).

• Right click over the chart background, and from the popup menu displayed, select the **Format Chart Area** command. This will display the Format Chart
Area dialog box.

- Select the required colour and then click on the **OK** button. An example is illustrated below.

---

### 6.4.1.3 Change the column, bar, line, pie slice colours in the chart/graph.

**To change the colour of a chart column, bar, line or pie slide**

- Display the slide containing the chart which you wish to modify.
- Double click over the chart area, so that the screen changes, allowing you to select individual elements within the chart.
- Double click on either the column, bar, line or pie slide, and you will see a dialog box, like the one illustrated. Select the required colour and then click on the **OK** button to apply the colour changes.
6.4.1.4 Change the chart/graph type.

To change the type of chart displayed
- Display the slide containing the chart which you wish to modify. Double click over the chart area, so that the screen changes and the chart edition icons are displayed in the toolbar.
- Click on the Chart drop down menu and select the Chart Type command. This will display a dialog box. Select the required chart type, and then click on the OK button.

6.4.2 Organisation Charts
6.4.2.1 Create an organisation chart with a labelled hierarchy.

To create a slide containing an organisational chart
- Insert a new slide and choose the Organization Chart AutoLayout.
- Double click on the icon within the new slide called Double click to add org chart. The Microsoft Organization Chart dialog will be displayed. You may see a dialog box telling you that this feature is not yet installed, in which case you will have to install it.

To enter information into an organisation chart box
- Enter the data into the boxes, overtyping the existing text (i.e. Type name here).

To navigate between organisation chart boxes
- Click on the box required using the mouse, or use the keyboard shortcuts listed below:
  - **Down Arrow**: Moves down one box to the next subordinate level.
  - **Left Arrow**: Moves one box to the left.
  - **Right Arrow**: Moves one box to the right.
  - **Up Arrow**: Moves up one box to the previous level.

6.4.2.2 Change the hierarchical structure of an organisation chart.

To move boxes within the chart
- Place the mouse pointer in the box you wish to move.
- Hold down the left-hand mouse button and drag the box to a new location. The mouse pointer changes to a four-headed arrow.
• Position the box over another box in the chart, the mouse pointer changes to one of the following to indicate where the box will be placed when you release the mouse button.

  **A left-pointing arrow:** Indicates that the box will be placed to the left of the existing box.

  **A right-pointing arrow:** Indicates that the box will be placed to the right of the existing box.

  **A chart box:** Indicates that the box will be placed below the existing box as a subordinate.

---

### 6.4.2.3 Add or remove managers, co-workers, subordinates in an organisation chart.

#### To add chart boxes

- You can add boxes to the chart using the icon bar at the top of the window.
- Click on the button which corresponds with the box you wish to add, i.e. subordinate, co-worker, etc.
- Click on the box in the chart to which you want to attach the new box. The new box is added to the chart and is selected.

**NOTE:** If you want to add more than one box at a time, click on the appropriate button on the icon bar several times, and then click on an existing box.

#### You can remove chart boxes in one of two ways

- Click on the box you want to remove to select it. Press the **Delete** key **OR** click on the box to select it and choose **Clear** from the **Organization Chart Edit** menu.

  **NOTE:** If you want to delete more than one box. Press the **Shift** key as you click on the boxes to select them and then press the **Delete** key.

---

### 6.4.3 Drawn Objects
6.4.3.1 Add different types of drawn object to a slide: line, free drawn line, arrow, rectangle, square, circle, text box, other available shapes

To display the drawing toolbar
- Right click on any toolbar and from the popup menu displayed select Drawing.

To draw a line
- Select the Line icon from the Drawing toolbar. The mouse pointer changes into a cross-hair pointer when moved over the slide.

- Click at the location where you want the line to begin and drag. Release the mouse button when you want the line to end. A line appears between the beginning and end point.

TIP: To draw a line which is perfectly horizontal or vertical, depress the Shift key while dragging.

To add a free drawn line
- Click on the AutoShapes button within the Drawing toolbar and from the popup menu displayed, select Lines.
- Click on the Lines command.
- From the submenu, select the Scribble icon.

- Click at the location where you want the line to begin and start moving the mouse. Release the mouse button when you want the line to end.
To insert a line with an arrow on it
- Click on the AutoShapes button within the Drawing toolbar and from the popup menu displayed, select Lines. Click on the Lines command. From the submenu, select the Arrow icon.

- Click at the location where you want the line to begin and start moving the mouse. Release the mouse button when you want the line to end.

To insert an arrow
- Click on the AutoShapes button within the Drawing toolbar and from the popup menu displayed, select Lines. Click on the Block Arrows command. From the submenu, select the required arrow type.

- Click at the location where you want the arrow to begin and start moving the mouse. Release the mouse button when you want the arrow to end.

To insert a rectangle
- Click on the Rectangle icon within the Drawing toolbar.

- Move the mouse pointer over the slide area and click at the position where you wish to start drawing the rectangle.
- Move the mouse pointer diagonally across the screen.
- Release the mouse pointer when you have finished.
To insert a square
• Click on the Rectangle icon within the Drawing toolbar.

• Depress the Shift key (and keep it depressed)
• Move the mouse pointer over the slide area and click at the position where you wish to start drawing the square.
• Move the mouse pointer diagonally across the screen.
• Release the mouse pointer when you have finished.
• Release the Shift key.

To insert an oval
• Click on the Oval icon within the Drawing toolbar.

• Move the mouse pointer over the slide area and click at the position where you wish to start drawing the oval.
• Move the mouse pointer diagonally across the screen.
• Release the mouse pointer when you have finished.

To insert an circle
• Click on the Oval icon within the Drawing toolbar.

• Depress the Shift key (and keep it depressed)
• Move the mouse pointer over the slide area and click at the position where you wish to start drawing the circle.
• Move the mouse pointer diagonally across the screen.
• Release the mouse pointer when you have finished.
• Release the Shift key.

To insert a Text Box
• You can insert a new text box using the Text Box icon. This icon is contained on the Drawing toolbar.

Once you have clicked on this icon, click within the body of the slide. A text
box will be inserted as illustrated.

- You may start to enter text within this text box, as illustrated.

6.4.3.2 Change drawn object background colour, line colour, line weight, line style.

To change an object’s background colour, line colour, line weight and line type
- Click on an object to select it. Double click on the object to display a dialog box, similar to the one illustrated.

- Make sure that the Colors and Lines tab is selected. To change the background colour, click on the down arrow to the right of the Color option within the Fill section. Select a colour as required.
• To change the background colour, click on the down arrow to the right of the **Color** option within the **line** section. Select a colour as required.

• To change the line weight, click on the up or down arrow to the right of the **Weight** option within the **Line** section. Select a line weight as required.

• To change the line style, click on the down arrow to the right of the **Style** option within the **Line** section. Select a line style as required. When you have made your sections, click on the **OK** button.
6.4.3.3 Change arrow start style, arrow finish style.

To change the arrow start and end styles

- Select the arrow.
- Double click on the arrow to display the Format AutoShape dialog box.
- If necessary select the Colors and Lines tab within the dialog box.
- To change the arrow start style, click on down arrow to the right of the Begin Style section of the dialog box, and select the required style.

![Arrow Styles](image1)

- To change the arrow start style, click on down arrow to the right of the End Style section of the dialog box, and select the required style.

![Arrow Styles](image2)

- When you have selected your modifications, click on the OK button the close the dialog box and apply the changes.

6.4.3.4 Apply a shadow to a drawn object.

To add a shadow effect to an AutoShape

- Select the AutoShape to which you wish to apply a shadow effect.
- Click on the Shadow icon (displayed within the Drawing toolbar). A popup menu will be displayed, from which you can select the required type of shadow effect.
• Click on the required shadow effect and the shadow will be applied, as illustrated.

6.4.3.5 Rotate or flip a drawn object.

To free rotate an object
• Select the shape which you wish to rotate.
• Click on the Free Rotate tool, which allows you to rotate an object by dragging with the mouse. To do this drag one of the shape handles.

NOTE: You can also use the Rotate Left or Rotate Right commands. To do this click on the Draw button (on the Drawing toolbar) and from the popup menu displayed, select the Rotate or Flip command which will display a popup submenu, from which you can select the desired command, such as Rotate Left or Rotate Right

To flip an object
• Select the shape which you wish to flip.
• Click on the Draw button (on the Drawing toolbar) and from the popup menu displayed, select the Rotate or Flip command, which will display a popup
submenu, from which you can select the desired command, such as **Flip Horizontal** or **Flip Vertical**.

---

6.4.3.6 Align a drawn object: left, centre, right, top, bottom of a slide.

**To align objects using the Draw menu**

- Select the objects you wish to align.
- Click the **Draw** icon on the **Drawing** toolbar to display the **Draw** menu.

- Select **Align or Distribute** to display the alignment submenu. Choose the type of alignment you want. The selected objects align according to your selection. Objects are aligned according to their selection rectangles, rather than the shapes themselves.

---

6.4.3.7 Resize drawn object, chart within a presentation

**To resize a drawn object or chart**

- Select the drawn object or chart by clicking on it once.
- Move the mouse pointer to one corner of the selected item, until the mouse pointer changes to a line at 45 degrees with an arrowhead at each end.
- Depress the mouse button and drag to resize the image within the slide.
- Release the mouse button.
6.4.3.8 Bring an object to the front or back.

What is object ordering?
- When you draw objects on a slide, the first object you draw is on the bottom, and the last object you draw is on the top. The placement of objects can be changed using the Bring to Front, Send to Back, Bring Forward and Send Backward commands.

**NOTE:** This is only relevant where two objects overlap on the slide.

To bring objects forwards or send them backwards
- Select the object you wish to move forward or backwards.
- Right click to display a popup menu, as illustrated.

- Select Order to display the Order submenu.
- Select Bring To Front or Send To Back.
- The selected object is moved to the top or bottom of the stack.

6.4.4 Duplicate, Move, Delete

6.4.4.1 Duplicate a chart/graph, drawn object within the presentation or between open presentations.

To copy a chart (or drawn object) within a presentation
- Click once on the chart (or drawn object), to select it.
- Click on the Edit drop down menu and select the Copy command.
- Display the slide within the presentation to which you wish to copy the chart (or drawn object).
- Click on the Edit drop down menu and select the Paste command.
To copy a chart (or drawn object) from a slide in one presentation to a slide within a second presentation

- Click once on the chart (or drawn object), to select it.
- Click on the Edit drop down menu and select the Copy command.
- Switch to, or open the second PowerPoint presentation to which you wish to copy the selected chart (or drawn object).
- Display the slide within the second presentation to which you wish to copy the chart (or drawn object).
- Click on the Edit drop down menu and select the Paste command.

6.4.4.2 Move a chart/graph, drawn object within the presentation or between open presentations.

To move a chart (or drawn object) within a presentation

- Click once on the chart (or drawn object), to select it.
- Click on the Edit drop down menu and select the Cut command.
- Display the slide within the presentation to which you wish to move the chart (or drawn object).
- Click on the Edit drop down menu and select the Paste command.

To move a chart (or drawn object) from a slide in one presentation to a slide within a second presentation

- Click once on the chart (or drawn object), to select it.
- Click on the Edit drop down menu and select the Cut command.
- Switch to, or open the second PowerPoint presentation to which you wish to move the selected chart (or drawn object).
- Display the slide within the second presentation to which you wish to move the chart (or drawn object).
- Click on the Edit drop down menu and select the Paste command.

6.4.4.3 Delete a chart/graph, drawn object.

To delete a chart (or drawn object)

- Click once on the chart or drawn object to select it and then press the Del key.
6.5 Slide Show Effects

6.5.1 Preset Animation

6.5.1.1 Add preset text or image animation effects to slides. Change preset animation effects on text or images.

What are the animation effects?
- Animation effects allow you to add a range of special effects to your slide shows and include:
  - Drive-in Effect
  - Flying Effect
  - Camera Effect
  - Flash Once
  - Laser text Effect
  - Typewriter Text Effect
  - Reverse Text Build
  - Drop-in Text Effect

To display the Animation Effects toolbar
- Click on the View drop down menu and select the Toolbars command. From the submenu displayed, select Animation Effects.

- To make a slide title drop in during a show
- To make text build one paragraph at a time
- To make text “drive” into the slide
- To make text “fly” into the slide
- To make text “shutter” into the slide
- To make text or object flash
To make text/objects appear from the top right of a slide

To make text appear one character at a time

To reverse the order of a build

To make text “rain” from the top of a slide

To alter the order of a build

To open the Animation Settings dialog box

To preview an animation effect

To add a preset animation effect

- Select the text or object to which you wish to apply the animation.
- Either click on the Slideshow drop down menu, then select the Preset Animation command and then from the submenu select the required preset animation type
- OR display the Present Animation toolbar, and select the required animation type.

To change a preset animation effect

- Select the text or object to which you have previously applied an animation effect.
- Click on the Slideshow drop down menu, then select the Preset Animation command and then from the submenu select the required preset animation type

6.5.2 Transitions

What are slide show transitions?

- Slide show transitions are special effects you can add to a slide show to determine how one slide moves or blends into the next slide within the presentation.
6.5.2.1 Add transition effects between slides. Change transition effects between slides.

To add transitions to a slide show
- Change to Slide Sorter view by clicking on the Slide Sorter icon.
- Select Slide Transition from the Slide Show menu, to display the Slide Transition dialog box.
- Select the transition you require from the Effect drop down list.

- Click on the transitions to see a preview of them applied to the picture in the Preview box. To see the transition again, click on the picture.
- Select how fast you want the transition to take place by selecting Slow, Medium, or Fast. You can preview the speed you have chosen in the Preview box.
- To change the transition of the current slide only, click on Apply. To change the transition of all slides in the presentation, click on Apply To All.

To change a transition effect
- To modify an existing transition effect, simply apply a new transition using the Slide Transition dialog box.
6.6 Prepare Output

6.6.1 Preparation

6.6.1.1 Select appropriate output format for slide presentation such as: overhead, handout, 35 mm slides, on-screen show.

To set the slide format
- From the File menu, select Page Setup to display the Page Setup dialog box.
- Click on the down arrow on the Slides sized for box and choose one of the options.
- If you want to begin numbering your slides with any number other than one, enter a new number in the Number slides from box.
- In the Orientation section, select the orientation for your slides in the Slides box. Choose either Portrait or Landscape.
- In the Notes, handouts & Outline section, select the orientation for your notes, handouts and outlines. Choose either Portrait or Landscape.
- Select OK to accept the slide setup.

6.6.1.2 Spell-check a presentation and make changes such as: correcting spelling errors, deleting repeated words.

To use the Spelling Checker
- Click on the Spelling icon on the Standard toolbar. PowerPoint begins checking the spelling. If PowerPoint comes across a word it does not recognise, the Spelling dialog box appears.
• In the example shown, PowerPoint has found the word ‘hello’ incorrectly spelt. The incorrect word is displayed in the **Not in dictionary** box. In the **Change to** box a replacement word is suggested, and other possible replacements are listed in the **Suggestions** box. Choose from the following options:

**Ignore:** Ignores the word.

**Ignore All:** Ignores all future occurrences of the word found in the document.

**Change:** Changes the word to the suggested word in the **Change to** box. You can select an alternative word from the **Suggestions** box.

**Change All:** Changes all future occurrences of the word in the document to the word of your choice.

**Add:** Adds the word to the custom dictionary.

**Suggest:** Suggests other replacement words.

When you have finished checking the presentation, PowerPoint displays a message telling you it has finished. To exit the spelling checker, select **Close**.

---

### 6.6.1.3 Add notes (for the presenter) to slides

**To add notes to a slide presentation**

• Make sure that you are viewing your presentation in Normal View. If necessary, click on the **Normal View** icon at the bottom, left of your screen.

• You will see a section, illustrated below, which allows you to “**Click to add notes**”. Simply click here and start typing.
6.6.1.4 Change slide setup, slide orientation to portrait, landscape. Change paper size.

To set slide orientation and page size

- Click on the File drop down menu and select the Page Setup command to display the Page Setup dialog box.

- In the Slides sized for section, select the required paper size.

- In the Orientation section, select the orientation for your slides in the Slides box. Choose either Portrait or Landscape.

- Click on the OK button to confirm your choices.
6.6.1.5 Duplicate, move slides within a presentation, between open presentations

**To move a slide within a presentation**
- Display the presentation in *Slide Sorter* view.
- Select the slide which you wish to move.
- Depress the mouse button and drag the selected slide to the location (between two slides) to which you wish to move the selected slide. When you release the mouse button the slide will move.

**To copy a slide within a presentation**
- Display the presentation in *Slide Sorter* view.
- Select the slide which you wish to copy.
- Depress the *Ctrl* key (and keep it depressed)
- Depress the mouse button and drag the selected slide to the location (between two slides) to which you wish to move the selected slide.
- Release the *Ctrl* key.
- When you release the mouse button the slide will be copied to the required location.

**To move a slide from one presentation to another presentation**
- Display the presentation in *Slide Sorter* view.
- Select the slide which you wish to move.
- Click on the *Edit* drop down menu and select the *Cut* command.
- Switch to, or open the second PowerPoint presentation to which you wish to move the slide.
- Display the second presentation in *Slide Sorter* view.
- Click between the two slides to which you wish to move the original slide.
- Click on the *Edit* drop down menu and select the *Paste* command. The slide will be displayed within the second presentation.

**To copy a slide from one presentation to another presentation**
- Display the presentation in *Slide Sorter* view.
- Select the slide which you wish to copy.
- Click on the *Edit* drop down menu and select the *Copy* command.
- Switch to, or open the second PowerPoint presentation to which you wish to copy the slide.
- Display the second presentation in *Slide Sorter* view.
- Click between the two slides to which you wish to copy the original slide.
• Click on the **Edit** drop down menu and select the **Paste** command. The slide will be displayed within the second presentation.

### 6.6.1.6 Delete a slide, slides.

**To delete a slide using the drop down menus**
- Display the slide which you wish to delete.
- Click on the **Edit** drop down menu and select the **Delete Slide** command.

**To delete a slide using the Del key**
- Display the presentation in **Slide Sorter** view.
- Select the slide which you wish to delete.
- Press the **Delete** key on your keyboard.

**To delete multiple slides (in one action)**
- Display your presentation within **Slide Sorter** view.
- Click on the first slide which you wish to select.
- Depress the **Ctrl** key (and keep it depressed).
- Click on the other slides which you wish to select for deletion.
- Release the **Ctrl** key and press the **Del** key.

### 6.6.2 Printing

**6.6.2.1 Print entire presentation, specific slides, handouts, notes pages, outline view of slides, number of copies of presentation, print presentation to file.**

**To print your entire presentation**
- Click on the **Print** icon, displayed within the Standard Toolbar.
To print just the current slide
- Click on the File drop down menu, displayed within the Standard Toolbar, and select the Print command. In the Print range section of the dialog box select the Current slide button. Make other selections as required and then click on the OK button.

To print particular slides
- Click on the File drop down menu, displayed within the Standard Toolbar, and select the Print command. In the Print range section of the dialog box select the Slide button. In the example shown we have decided to print slide 1, slide 2 and slides 5-8 inclusive. Make other selections as required and then click on the OK button.

To print multiple copies
- Click on the File drop down menu, displayed within the Standard Toolbar, and select the Print command. In the Copies section of the dialog box, use the up and down arrows to set the required number of copies. In the example shown, we have set 5 copies to be printed. Make other print choices as required and click on the OK button.

To print a presentation to a file
- Click on the File drop down menu, displayed within the Standard Toolbar, and select the Print command. In the Printer section of the dialog box, click...
on the **Print to file** check box. Make other print choices as required and click on the **OK** button.

![Print dialog box](image)

**To print Handouts**
- Click on the **File** drop down menu and select the **Print** command. A dialog box is displayed.
- Click on the down arrow to the right of the **Print What** section of the dialog box.
- Select **Handouts** from the drop down menu displayed.

![Handouts dialog box](image)

- Select the number of **Slides per page**, and whether you wish them displayed **horizontally** or **vertically**.
- You can also, optionally, select the **Scale to fit page** box.
- You may wish to enter a number in the **Number of copies** section of the dialog box, so that you can print multiple copies. Click on the **OK** button to start printing.

**To print Notes or a Presentation Outline**
- Click on the **File** drop down menu and select the **Print** command. A dialog box is displayed.
- Click on the down arrow to the right of the **Print What** section of the dialog box.
- Select **Notes Pages** or **Outline View** from the drop down menu displayed.

![Print what dialog box](image)

- You can also, optionally, select the **Scale to fit page** box.
• You may wish to enter a number in the **Number of copies** section of the dialog box, so that you can print multiple copies. Click on the **OK** button to start printing.

### 6.6.3 Deliver a Presentation

**What is a Slide Show?**

• Rather than printing out your presentation, you may want to run it as an electronic slide show from your computer. This means that each slide in your presentation, along with its text, art, and graphics, takes up the whole screen. All other screen elements are hidden.

#### 6.6.3.1 Hide or show slides.

**To hide slides in a slide show**

• Select the slide(s) you wish to hide.
• Select **Hide Slide** from the Slide Show menu, or click on the Hide Slide icon on the Slide Sorter toolbar if you are working in Slide Sorter view.
• The slide will be hidden during a slide show.
• In Slide Sorter view an icon appears below the slide, which contains the slide number with a line through it, to indicate that it is hidden.
• During a slide show, if you wish to display a hidden slide right-click on the preceding slide to display the shortcut menu, select **Go** and then **Hidden Slide** or simply press the **H** key.

**To see which slides are formatted as hidden**

• Switch to Slide Sorter view and the hidden slide(s) will be indicated as illustrated below.
To display a hidden slide during a slide show
- Within the slide show, right-click on the slide which precedes the slide which is hidden. Click on the Go command, and then click on the hidden slide to display it.

6.6.3.2 Start a slide show, start a slide show on any slide.

To start a slide show
- Open your presentation and click the Slide Show icon or select the Slide Show command from the View menu.

To start a slide show on a specific slide
- Display on screen the slide with which you wish to start the presentation (i.e. in Normal Mode or Slide View Mode).
- Click the Slide Show icon to start the presentation.
To display the slide show shortcuts
- When the slide show is running press the F1 key to display a list of shortcuts.

To move to the next slide
- Use any of the following options:
  - Left Mouse Click
  - N
  - Space Bar
  - Right Arrow
  - Down Arrow
  - Enter
  - Page Down
  - Right Click - Select from Popup Menu

To move to a previous slide
- Use any of the following options:
  - Backspace
  - P
  - Left Arrow
  - Up Arrow
  - Page Up
  - Right Click - Select from Popup Menu
To return to the first slide

- Press both mouse buttons for 2 Seconds.

To blank the screen to black

- Press **B** once to apply.
- Press **B** once more to remove.

To blank a screen to white

- Press **W** once to apply.
- Press **W** once more to remove.

To exit a screen show

- Use any of the following options:
  - **Esc**
  - **Ctrl+Break**
  - "_" 

The slide show "right click menu"

- Right clicking within the slide show will display the following popup menu, allowing you to navigate through the presentation.